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Chapter 1. Introducing Screen Customizer

IBM Screen Customizer (Screen Customizer) provides a graphical user interface for
IBM Host On-Demand or IBM Personal Communications 3270 and 5250 sessions.
Extensive customization capability is provided that does not require programming
or modification of host applications.

Components
There are three components:

Administrator
Captures host screens from an active host session and saves them as maps
that can be modified in the Customization Studio. You can test customized
screens and templates in the Administrator. The Administrator can be
installed and run only on a Windows 95, 98, 2000 or NT workstation. It
cannot be downloaded from a Web server.

Customization Studio (Studio)
Customizes host screens that were captured in the Administrator. The
Studio is also used to set global defaults for font, colors, button styles, and
other attributes, and save them in a template. The Studio can be installed
and run only on a Windows 95, 98, 2000 or NT workstation and does not
require a host connection. It cannot be downloaded from a Web server.

Client RunTime
Presents a default or customized graphical interface for host sessions. The
Client is the interface used by end users to view screens customized in the
Studio. It resides on a Web server or a client workstation.

With Host On-Demand, the Screen Customizer components run as Java applets in
a browser; with Personal Communications, they run as Java applications. The same
customized screens can be used with either product.

Features
Main features of Screen Customizer:

Customize green screens
Convert a green screen into a graphical or Web-like user interface, with
radio buttons, images, Web links, check and choice boxes, colors, and many
other customization options. No changes are required to original host
applications.

Global Variables
Save data from one screen and use it as information for another screen or
to perform calculations.

Get-to-the-Point
Hide unnecessary screens so that users see only the screens that they need
to see.

Web Links
Create buttons that launch custom URLs in a browser linking host
applications to local or Internet Web pages.

© Copyright IBM Corp. 1999, 2000 1



Context-sensitive help
Create context-sensitive field help for host applications.

Valid values
Create a list of values that are valid for a field. Creating a list makes it
easier for the user and minimizes errors.

Run user applet
Start a user-defined applet at the same time as the session, or at a later
time. Applets can interact with a session using HACL, the Screen
Customizer terminal bean, or the Custom Component Interface (CCI).

Add macro buttons
Add macro buttons to perform host-system functions, such as sending data
to specific fields.

User groups
Create unique customizations for different groups of users.

Transfer files
Transfer files between your workstation and S/390 or AS/400 host
systems.

What’s New in Version 2
The following functions and enhancements have been added to Version 2:

Global customization enhancements
Customizing screens is easier with the template enhancements. You can
control the look and function of many different emulator screens at once
by creating templates that can be automatically applied to screens without
having to modify each screen individually.

Simplified screen capture process
The Administrator toolbar makes the process of capturing and customizing
screens quick and easy. The toolbar buttons provide quick access to the
functions you use every day when working with screens. There are buttons
to capture a screen, start the Studio, and work with screen IDs.

Web link button improvements
Additional options have been added for Web link buttons. Text for links
changes color when the mouse pointer is held over it, displaying a
standard Web link. Settings can be saved for individual Web links.

Light pen support
Use your mouse as a light pen pointer when accessing host applications
that require a light pen. Light pen fields can be displayed as check boxes
or buttons, depending on the type of field.

Additional language support
Support for Hindi and Thai languages have been added.

AS/400 Subfiles
AS/400 subfiles are automatically converted into multi-column tables with
button hotspots that send the appropriate commands for manipulating
objects in the subfile list.

Auto install for AIX
Provides a graphical user interface for installing Screen Customizer on AIX.
This makes it easy to select installation options and reduces possible
installation errors.
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Screen Customizer API
The Custom Component Interface (CCI) allows you to interact with
graphical objects on the screen. You can set properties for graphical
interface objects and in some cases the data represented by the object (for
example, button caption or choice options). The Screen Customizer API is
documented in the CCI Reference included with the Host On-Demand
Host Access Toolkit.

Screen Customizer bean
Use Screen Customizer within your own applications or embedded directly
into a Web page. The bean allows rapid application development with full
capabilities to display customized screens. The Screen Customizer bean
works with most of the current host access beans. It is documented in the
Host Access Beans for Java Reference included with the Host On-Demand
Host Access Toolkit.

Service bundler
Provides an easy way to collect the information needed by IBM Service if
there is a problem with Screen Customizer.

Chapter 1. Introducing Screen Customizer 3
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Chapter 2. Planning for Screen Customizer

To use the Screen Customizer Client or Administrator, you must have either Host
On-Demand V5 or Personal Communications V5 installed. Screen Customizer
depends on the transports provided by these products to connect to host systems.
The Customization Studio can be used to customize screens without being
connected to a host system and, therefore, does not depend on Host On-Demand
or Personal Communications.

Before installing Screen Customizer, Host On-Demand or Personal
Communications must be installed. If you need to reinstall Host On-Demand for
any reason, you must reinstall Screen Customizer afterwards. If you don’t, Screen
Customizer might not run correctly and some functions could be missing.

You should not install a language for Screen Customizer if it has not been installed
for Host On-Demand or Personal Communications. If you install a language that
was not installed for the base product, Screen Customizer will not work in that
language.

If you are installing the full version of Screen Customizer on a Host On-Demand
server, the Screen Customizer RunTime client replaces the default graphical user
interface provided with Host On-Demand.

Required software
To install the Administrator or Client, you must have one of the following
installed:
v Host On-Demand Version 5.0
v Personal Communications Version 5 with Apar IC27134

The installation program detects which product you have installed and installs the
appropriate files. If both products are installed, you choose which one to use with
Screen Customizer.

The Customization Studio does not require either product to be installed.

Supported operating systems

Client
The Client can be installed on a Host On-Demand server or on a locally-installed
client, or Personal Communications workstation

Supported operating systems to install the Client on a Host On-Demand
locally-installed client include:
v Windows NT 4.0 with SP5
v Windows 2000
v Windows 95 and Windows 98

Supported operating systems to install the Client on a Host On-Demand server
include:
v Windows NT 4.0 with SP5
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v Windows 2000
v Windows Terminal Server Version 4
v AIX (R) Version 4.2.x, 4.3.3, and 4.3.4
v OS/2 (R) Warp Version 4 and OS/2 Warp Server for e-Business 4.5
v Novell NetWare Version 4.0 and 5.0
v Sun Solaris Version 2.6 and 2.7
v HP/UX 10.20
v RedHat Linux Version 6.2
v SUSE 6.4
v Caldera Version 2.3
v TurboLinux Version 6.0
v Unixware Version 7
v OS/400 (R) Version 4.3, V4R4, and V4R5
v OS/390 (R) Version 2.5, V2.6, V2.7, V2.8, V2.9, V2.10

Supported operating systems to install the Client on a Personal Communications
workstation:
v Windows NT Version 4.0 with SP5
v Windows 2000
v Windows 95 and Windows 98

Administrator
Supported operating systems to install the Administrator on a Host On-Demand
server or locally-installed client, or Personal Communications workstation include:
v Windows NT Version 4.0 with SP5
v Windows 2000
v Windows 95 and Windows 98

Customization Studio
Supported operating systems to install the Studio include:
v Windows NT Version 4.0 with SP5
v Windows 2000
v Windows 95 and Windows 98

Supported browsers
The following browsers can be used to run Screen Customizer with Host
On-Demand:
v Netscape Navigator 4.6, or 4.7
v Netscape Navigator 4.61 (OS/2)
v Microsoft Internet Explorer 4.01 with SP1, 5.0, or 5.1

Packaging
Installation files are provided in the following formats:
v InstallShield for Windows NT, Windows 95, Windows 98, and Windows 2000
v ZIP for OS/2 and NetWare
v TAR for UNIX
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v InstallManager for AIX
v Savefile for OS/400

For System/390, Screen Customizer Clients are provided on three different media:
v 6250 tape
v 3480 cartridge
v 4 millimeter cartridge

Included in the System/390 tape package is a Screen
Customizer multiplatform CD.

Host requirements

OS/390
Some VTAM installations have an optimizer installed that can merge fields to
enhance performance. This option must be turned off when you capture screens.

A field merge effect may also be caused by CICS and IMS applications that write
the data stream directly, rather than utilizing BMS or MFS mapping systems.
Screens similar in appearance may significantly differ in the number and length of
fields, and this can cause problems associating customized maps to a screen.

Screen Customizer’s default interface can accommodate such data streams, because
it creates an interface instantly according to the data stream that is sent to the
client. However, customizing such screens can be difficult because you have to
account for all of the variations of the screen, and import the customization to all
versions of the screen.

AS/400
The appearance of an error message or a copyright notice in 5250 sessions or the
opening of AS/400 application subfiles causes detection of a change in the
appearance of the screen by Screen Customizer. Therefore, to completely customize
the application, each of these screens must be assigned a screen ID, and then be
customized, or you can use tags.

Tags for these screens should identify a screen element that remains unchanged by
the appearance of these items. Consequently, when the new screen items are sent,
the customized map would just have the text of the error message or subfile
appear as part of the customized screen. Another option is to turn the subfile
tables off for AS/400 subfile screens, which you can do in the Studio.

Chapter 2. Planning for Screen Customizer 7
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Chapter 3. Installing Screen Customizer

Screen Customizer includes:
v Client for Host On-Demand
v Client for Personal Communications (Windows only)
v Administrator (Windows only)
v Studio (Windows only)

Migrating from ResQ!Net
Customizations created using ResQ!Net are saved by default in the /hod/at2custom
directory, which has several subdirectories. For Screen Customizer, the equivalent
directory is hod/custom which has all of the equivalent subdirectories (at2 has
been removed).

If you are installing on a Windows system, migration is automatic. The setup
program copies the contents of the ResQ!Net directories to the equivalent Screen
Customizer directories. However, if you have customizations saved in directories
other than the default directories, you must manually copy them to the new path.
On non-Windows platforms, you must manually copy all customizations. The files
in the following original ResQ!Net directories must be moved to the new Screen
Customizer directories.

ResQ!Net Directory Screen Customizer Directory

at2custom/at2hlp custom/lang/help

at2custom/at2img custom/img

at2custom/at2lst custom/lst

at2custom/at2maps custom/map

at2custom/at2ps custom/ps

at2custom/at2ref custom/ref

at2custom/at2wsp custom/wsp

In addition, the following files must be renamed from the original ResQ!Net
extension to the new Screen Customizer extension.

ResQ!Net Extension Screen Customizer Extension File Purpose

a2h hlp User-created field-level help

a2m scm Screen customization data

a2p psd Base screen data

a2b tlb Customized toolbar

a2l lst Valid-value list

a2r ref
Reference file for field help and
valid-value list

a2t tpl Template

© Copyright IBM Corp. 1999, 2000 9



Customizations saved in a directory other than at2custom, can be migrated by first
renaming the at2* subdirectories within the alternate directory to the new
subdirectory names and then by renaming the original file extensions to the new
extensions.

Migrating from Version 1
In Version 2, profiles are no longer supported and have been replaced with global
templates. When installing on Windows, profiles are automatically migrated from
the default custom/wsp directory to the equivalent template name (with a .tpl
extension) in the custom/map directory. Profiles that are not located in the default
directory, for example, a user-defined directory mycustom/wsp, are not migrated
automatically during installation. A profile migration utility is provided that
migrates those profiles to the new template format. On Windows systems, the
migration utility is started from the Start > IBM Screen Customizer menu. On
non-Windows systems, the utility can be started manually.

If you are migrating from ResQ!Net, you must do those
steps before migrating to Screen Customizer V2.

To start the migration utility manually, enter the following command (on one line):
java -classpath publish_dir\lib\scmigr.jar;publish_dir\lib\rt.jar;
publish_dir\lib\i18n.jar com.ibm.hi.customizer.util.profile.ProfileMigrator ProfileDir=profile_dir Te

Installing Screen Customizer on Windows
You can install Screen Customizer on either Host On-Demand or Personal
Communications, but not both. If both products are installed, you are given a
choice. You can then choose to install all the components (including the
Administrator), the Client only, or the Customization Studio only. If neither Host
On-Demand or Personal Communications is installed, you can install only the
Studio.

To install Screen Customizer:
1. Insert the CD and wait for the start window.
2. Click Install.
3. Follow the directions in the installation windows. To install only one

component, choose Custom install.

You can also run setup.exe, located in the win32 directory, to start the installation
program.

Default installation directories
When you install the Client or Administrator on a Host On-Demand server, it is
installed in the Host On-Demand publish directory (/hostondemand/hod/ is the
default).

When you install the Client or the Administrator on a Host On-Demand
locally-installed client, it is installed in the hostondemand/lib directory.

When you install the Client or Administrator on Personal Communications, it is
installed in the Personal Communications installation directory.
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When you install the Studio only, it is installed in the c:/Program Files/IBM/Screen
Customizer directory.

If you cache Host On-Demand with the default version of
Screen Customizer enabled and then install the full
version of Screen Customizer, the cached client might not
run correctly.

Installing the Client on OS/2
You can install only the Client on OS/2. It must be installed in the Host
On-Demand server publish directory so that it is available to client workstations.

To install the Client:
1. Insert the CD.
2. Change to the Host On-Demand publish directory.
3. To extract the Client files, run the following command:

unzip -d [cd_rom]:\zip\client.zip

4. To extract the documentation file:
unzip -d [cd_rom]:\zip\doc.zip

v unzip is your unpacking program. It must support long filenames.
v -d is the parameter that recreates the zipped directory structure.
v [cd_rom] is the CD-ROM drive letter.
v ZIP is the directory on the CD.

Installing the Client on Novell NetWare
You can install only the Client on Novell NetWare. It must be installed in the Host
On-Demand server publish directory so that it is available to client workstations.

To install the Client:
1. Insert the CD.
2. Change to the Host On-Demand publish directory.
3. To extract the files, run the following command from the Host On-Demand

publish directory:
unzip -d [cd_rom]:\zip\client.zip

4. To extract the documentation file:
unzip -d [cd_rom]:\zip\doc.zip

v unzip is your unpacking program. It must support long filenames.
v -d is the parameter that recreates the zipped directory structure.
v [cd_rom] is the CD-ROM drive letter.
v ZIP is the directory on the CD.

Installing the Client on AIX
You can install only the Client on AIX. It must be installed in the Host On-Demand
server publish directory so that it is available to client workstations.

You can install the Client two ways:
v Graphical interface
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v Silent mode using a response file

Using the graphical interface
To install the Client using the graphical interface:
1. Mount the CD-ROM drive and insert the CD.
2. Change to the root directory of the CD and enter setupaix.sh.
3. Click Install Product.
4. Follow the directions in the installation windows.

Installing the Client on UNIX
You can install only the Client on UNIX operating systems. The Client must be
installed in the Host On-Demand server publish directory so that it is available to
client workstations.
1. Insert the CD and mount it.
2. Change to the Host On-Demand publish directory.
3. Untar the client.tar file (includes the English files) and install the Client base

files into the HOD directory. This step assumes that the tar files are in the
/cdrom/tar directory.
Run the following command from the publish directory:
tar -xf /cdrom/tar/client.tar

For each additional language that you want to install:
tar -xf /cdrom/tar/sc_lang.tar

For example, tar -xf /cdrom/tar/sc_ko.tar.
4. To extract the documentation file (includes all languages):

tar -xf /cdrom/tar/doc.tar

Installing the Client on OS/400
1. Insert the Screen Customizer CD.
2. Run the following command:

RSTLICPGM LICPGM(5648D76) DEV(OPT01)

v RSTLICPGM starts the OS/400 installation program
v LICPGM(5648D76) is the Screen Customizer program number to install
v DEV(OPT01) is the source device for the CD

Installing the Client on OS/390
For information about installing Screen Customizer on OS/390, refer to the
Program Directory supplied with the OS/390 Program Product.

Installing in silent mode on Windows or AIX
A silent installation installs Screen Customizer without displaying any windows or
asking for input. To perform a silent installation of Screen Customizer, you must
first create a response file that contains the information required on the installation
windows. Sample response files are provided and are located in the platform
specific \instmgr\ directory: server1.iss on Windows and install.script on AIX.
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They contain the default installation options. You can use those or create your
own. Once a response file is created, start the silent installation.

When you install in silent mode, there is no indication
that installation is in progress or that it is complete.

Windows
Recording a response file

1. Go to the \win32\ directory on the CD.
2. Run the following command:

setup.exe -r -f1d:\responsefile_path\response_filename.iss

v d:responsefile_path is the drive letter and the path where you want the response
file to reside.

v responsefile_name.iss is the name of the response file.

For example:
setup.exe -r -fld:\tmp\server1.iss

Installing in silent mode

1. Go to the \win32\ directory on the CD.
2. Run the following command:

setup.exe -s -f1d:\responsefile_path\responsefile_name

For example:
setup.exe -s -f1d:\temp\server1.iss -f2d:\temp\server1.log

AIX
Recording a response file

1. Go to the /instmgr/ directory on the CD.
2. Run the following command:

instaix.sh -r /responsefile_path/responsefile_name

v responsefile_path is the directory path where you want the response file to reside.
v filename.script is the name of the response file.

Examples:
instaix.sh -r ./tmp/install.script

/cdrom/instmgr/installaix.sh -r /tmp/install.script

Installing in silent mode

1. Go to the /instmgr/ directory on the CD.
2. Run the following command:

instaix.sh -p /responsefile_path/filename

Examples:
instaix.sh -p ./tmp/install.script

/cdrom/instmgr/installaix.sh -p /cdrom/instmgr/AIX/install.script

Options supported in silent mode

-r Records a response file.
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-s (Windows) -p (AIX) Runs a response file and installs.

-f1 path\responsefile_name Defines the name for the response file, in both record
and run modes. The path and filename must be 43
characters or fewer. There must not be a space between
parameter and value. The filename extension must be iss
for Windows and script for AIX.

-f2path\log_file_name Defines the log file and can be used in run mode to
create a file that contains a history of an installation. The
path and filename must be 43 characters or fewer. There
must not be a space between parameter and value.

The target system’s configuration must be the same as that of the source system
(the system on which the response file was created). For example, if the source
system has a previous installation of Screen Customizer, the target system must
have the same. If the source system installed Screen Customizer on the D drive,
the target system must also have a D drive.

Format of the silent mode installation log file
If an installation is not successful, the log file might indicate the reason. The format
of a log file is as follows:

[InstallShield Silent]
Version=v5.00.000
File=Log File
[Application]
Name=\Screen Customizer
Version=2.00.000
Company=IBM
[ResponseResult]
ResultCode=0

Result code values
The ResultCode indicates whether or not the installation was successful. Possible
values are:

0 Successful

-1 General error

-2 Mode not valid

-3 Required data not found in the response file

-4 Not enough memory available

-5 File does not exist

-6 Cannot write to the response file

-7 Cannot write to the log file

-8 Path to the response file is not valid

-9 Not a valid list type (string or number)

-10 Data type is not valid

-11 Unknown error during setup

-12

Dialogs are out of order. Since the dialog order depends
on what other related products were already installed on
the workstation, the target system must have the same
products.

-51 Cannot create the specified folder
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-52 Cannot access the specified file or folder

-53 Selected option is not valid

Common problems:
v The server1.iss or install.script file is not in the directory specified by the -f1

option.
v You changed the name or location of the response file and did not specify the

new name or location when you ran the setup.exe command to install the code.
v There is not enough space on specified target drive to install the code.
v You are installing or uninstalling Screen Customizer and you are not logged on

the target system with Administrator authority.
v There is an error in the syntax of the setup.exe command.
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Chapter 4. Starting Screen Customizer

After installing Screen Customizer, you are ready to start customizing your host
application screens. The online help provides detailed information about
customizing screens. The information here is intended to help you start Screen
Customizer and to provide some guidance and overview information for the steps
involved in customizing screens.

Basic steps for customizing screens
The basic steps for customizing host screens are listed here. These steps are
described in detail in a file named getstart.html located in the help directory. To
access the basic customization steps, click Start > Programs > IBM Screen
Customizer > Information Library > Basic Customization Steps. These steps might
not apply to your environment and don’t describe all of the Screen Customizer
functions. These are only the basic steps and are provided to help you understand
and get started with Screen Customizer.
1. Start the Customization Studio.
2. Create templates.
3. Start an Administrator session.
4. Capture the screens that you want to customize.
5. Go back to the Studio and customize individual screens (maps) created in the

Administrator.
6. Test and apply the customized screens with the templates in the Administrator.
7. Distribute the customized screens.

Starting the Customization Studio
To start the Customization Studio:
v From the Start menu, click Programs > IBM Screen Customizer > Customization

Studio.
v From an Administrator session, click File > Customize Screen or File >

Customize Template.

The Studio is used to create templates and to customize your host screens. You can
create templates to be applied globally to all host screens or to a specific host
screen. A template allows you to add objects to the area surrounding the host
screen. You can customize the colors, fonts and button styles for the entire screen.
During runtime, the template is applied to all host screens, whether they have
been customized or not.

After capturing host screens in the Administrator, use the Studio to customize
them. Captured screens are assigned IDs and saved as map files. Each screen, or
map, can be opened in the Studio and customized. Changes made to screens in the
Studio apply only to the screen ID with which they are associated.

You cannot use many of the Administrator or Studio
functions if the Host On-Demand cached client is
installed. To remove the cached client, follow the
appropriate procedure in the Host On-Demand Getting
Started guide.

© Copyright IBM Corp. 1999, 2000 17
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Starting the Administrator
You can use the Administrator with Host On-Demand or with Personal
Communications. After starting it, the available functions are the same.

You cannot load the Administrator through a Web server, it must be loaded from
the local file system. If the local system is a Host On-Demand server, a user
account, customadmin, is created in the HOD group. This can be administered
through the Host On-Demand Administration applet and used like any other user
account. Any type of session, including printer, VT and CICS sessions, can be
added to the account. Preferences are saved in HOD.customadmin.user in the
\private directory.

The Administrator runs live sessions to host applications. Screens that are to be
saved for customization are identified in these sessions. A screen ID must be
assigned to each screen; these IDs are added to a screen database file called
screen.db. Host screens are captured (saved) as Screen Customizer maps that serve
as the starting point for customization in the Studio. Both the screen database and
the screen maps are saved in the \custom\maps directory.

You can run the Administrator on more than one system to capture screens. If
users need customized screens from both systems, the contents of the screen
databases from both Administrator systems can be merged using the merge
database utility provided.

Starting the Administrator with Host On-Demand
Starting the Administrator from the Start menu opens the standard icon interface,
which is similar to the Host On-Demand interface.

To use the Administrator, configure and start a host session:
1. Click Start > IBM Screen Customizer > Administrator.
2. Click Add Sessions.
3. Right-click a session and select Copy.
4. Configure the session properties and make sure that Screen Customizer is set to

Administrator on the Screen tab.
5. Click OK.
6. Start the session by either double-clicking the icon or right-clicking it and

selecting Set Up Bookmark. When you set up a bookmark, the session starts
and you are reminded to create a bookmark. The next time you want to start
the session, select the bookmark. The Screen Customizer default GUI screen for
the host session appears.

Previously defined sessions might not be enabled for Screen Customizer.
Right-click the session and select Properties. Click the Screen tab and select
Administrator for the Screen Customizer field.

To use the interface that is similar to the ResQ!Net Administrator interface, load
HODCustomAdminBasic.html in a browser.

Starting Screen Customizer and a Host On-Demand session
simultaneously

You can have both interfaces running synchronously so that changes made on one
screen can be seen on the other. To do this, you must configure a Host On-Demand
session and specify the Administrator as a startup applet:
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1. Start a Host On-Demand client.
2. Right-click a session icon and select Properties.
3. Click the Advanced tab.
4. From the Auto-Start selection list, select Applet.
5. In the Auto-Start Name field, type com.ibm.hi.customizer.CSynchHOD.
6. Click the Screen tab and disable Screen Customizer.
7. Click OK.

Double-click the icon to start both Host On-Demand and Administrator sessions.
The Administrator can also be started from Host On-Demand’s Run Applet
window by entering the same class name as above.

Applet file names for Host On-Demand

The following applets are provided to use with Host On-Demand:

Type Description HTML file

Client
Any Host On-Demand client.
Provides an icon interface for starting
client sessions. (Recommended)

HOD*.html

Administrator
Provides an icon interface for starting
administrator sessions.
(Recommended)

HODCustomAdmin.html

Client
Basic interface for starting client
sessions. (Replaces ATTAppletH.html)

HODCustomClientBasic.html

Administrator
Basic interface for starting
administrator sessions. (Replaces
ATTAdminH.html).

HODCustomAdminBasic.html

Studio
Applet for starting Customization
Studio. (Replaces ATTStudio.html).

CustomStudio.html

To use the interface similar to ResQ!Net, load the Basic HTML files, for example,
HODCustomClientBasic.html.

Starting the Administrator with Personal Communications
To use the Administrator to start a host session:
1. Click Start > IBM Screen Customizer > Administrator.
2. A list of the WS files in your Personal Communications \private directory is

displayed. If you have WS files in any other directory, click Add Sessions and
follow the directions on the window to add them to the list.

3. Select a WS file.
4. Click Start or double-click the WS file to start the session.

To start multiple sessions, select multiple WS files in the list.

You can start specific sessions by adding the WS file name to the end of the
command line that launches a session:
1. Copy the default, or another profile session, shortcut (the session that is

launched from the start menu).
2. Open the properties for the Administrator shortcut.
3. Click the Shortcut tab.
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4. Add the following to the end of the command that starts the session:
Launch="wsfile_name"

If the WS file is stored in the local Personal Communications private directory,
specify only the WS file name, for example, Launch=″ralvm17.ws″. If the WS
file is stored somewhere else, add the full path:
Launch="D:\My Test Profiles\ralvm17.ws"

You can also add parameters and their values to the end of the command. For
example, add template=″mytemplate.tpl″ to specify a template to be used when
this session starts.

Starting Screen Customizer and a Personal Communications
session simultaneously

You can have both interfaces running synchronously so that changes made on one
screen can be seen on the other:
1. Start the Administrator with Personal Communications as described in the

steps above. This starts two sessions: an Administrator session and a hidden
Personal Communications session, that runs synchronously with the
Administrator session. They have the same session ID, for example, A but only
the Administrator session displays.

2. To see the hidden Personal Communications session, open a Personal
Communications window (start a session) for example, B. A connection is not
necessary; you need only to use the session menu bar.

3. On the session B menu bar, click Window > Show and select the Personal
Communications session A: SessionA started in Step 1.

When Screen Customizer is used with Personal Communications:
v You can have up to 4 Screen Customizer sessions and up to 22 normal Personal

Communication sessions. The actual maximum number of sessions that can be
started might be less if the workstation is low on resources.

v 5250 file transfer is supported only on a TCP/IP connection.
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Chapter 5. Creating and using templates

You can set overall defaults for several attributes of host screens so that you don’t
have to customize them for each screen. These changes can be saved in a template
to apply to host screens. A template can contain objects that you might need for
numerous screens in the area surrounding the host screen. For example, if you
know that you want all of your host screens to have the same image, navigation
buttons, a Web link button, and a customized toolbar, you can create one template
with those objects and apply it to all of the screens. You can then capture the
screens that you want to customize individually.

To create a template, in the Studio click File > New Template. A blank screen
appears with an area reserved for the host screen. You can change the size of the
host screen area and you can move it around but you cannot add objects to it.
There are a few options, such as colors, fonts, and button styles that can be applied
to the entire screen when specified in the template, unless they are overridden by a
specific setting in the customized screen.

Templates are saved in the map directory with the map files (captured screens). A
default global template named sc_global.tpl, is applied automatically to all host
screens that do not have a specific template associated with them. When you create
a template, use the default name. If you use a different name for the global
template, add the template parameter to the HTML file (Host On-Demand) or
parameters file (Personal Communications) used to start the Client.
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Chapter 6. Capturing screens

One of the primary purposes of the Administrator is to capture screens and turn
them into maps. Screen Customizer creates a screen signature based on the screen
structure, allowing you to set up a unique ID for each host screen. Without an ID,
you cannot customize a screen.

Screen information is saved as a .scm file (screenid.scm) in the /custom/map/
directory and is referred to as a map. If you save a map as a file with a name
different from its screen ID, or in a different directory, the customization changes
are not recognized, unless the directory’s name is specified in the startup HTML
file. Screens are also saved as psd files in the /custom/ps directory. The psd file
contains a presentation-space footprint that is used by the Studio when the screen
is customized.

Before you capture screens, you should erase any data in the input fields,
otherwise this data becomes the default input for that field in the Customization
Studio.

There are several ways to capture screens using the Administrator toolbar:
v To capture all of your screens while in the Administrator and customize them

later, for each screen you want to capture: enter a screen ID and a description on
the toolbar and click Capture.

v To capture the current screen and immediately customize it, enter a screen ID
and a description and click Customize.

v To capture a screen, give it a screen ID and extended description, or assign a tag,
and then optionally customize it in the Studio, click Properties.

Screen IDs and tags
A host screen is recognized by:
v Screen Structure

– Size and positions of all fields on the screen
– Total number of fields on the screen

v Tag

– Differentiates between screens that have the identical structure by
interrogating the contents of a screen field that is designated as the tag

– Allows unique screen IDs to be assigned for different modes of the same
screen

v Built-in screen IDs

If an application provides IDs for its screens, you can use them. To do so, set the
parameters IDFlag, IDFlagPos, IDPos in the Administrator and Client HTML
files for Host On-Demand or the parameter file for Personal Communications.

Assigning IDs
A screen ID is used to identify the host screen and must be 4 characters long.
Screen IDs must be unique. Optionally, you can give the screen a description,
which can be viewed in the Screen IDs window. Use a description to help you
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identify what the screen contains. You can also add an extended description by
clicking Properties on the Administrator toolbar.

Adding a tag
Most screens are unique and have at least one field that makes them different from
any other. For those screens, you can assign a unique ID to use as a reference for
the screen. If screens are identical except for field text, you can add a tag to the ID
so that each version of the screen can be identified and customized separately.

To add a tag for a screen, click Properties on the Administrator toolbar and then
click the Tag tab.

You can also use tags in the reverse manner, to have a single customization for
several screens that have different structures, for example, sub-file areas or error
messages can change the structure of a screen. If you have such a screen, find a
protected field that remains the same in every version of the screen, select up to
eight characters of it and define it as a tag. Setting a tag for a screen with a
changeable structure, in effect, gives each structure of the screen a different ID.

When multiple screens share the same system-assigned screen ID
If a single system-assigned screen ID in the host application applies to more than
one screen, you must take this into account when customizing. This may happen if
the host screens run in different modes (for example, Create, Review, and Update).
Shared IDs may also occur on menu screens that have the same structure. In these
cases, you must assign a tag to each form of the screen.

Moving a screen ID database
Because all user-created screen IDs are saved in a screen.db file, you must copy
this file along with the customization files when transferring screens to a different
location (for example, to the Host On-Demand server for distribution). The
screen.db file is located in the /custom/map directory. Read the Merge Screen
Database online help for more information on merging multiple screen.db files.
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Chapter 7. Customizing screens (maps) and applying
templates

Once a screen is captured, it can be customized in the Studio. If you assign an ID
to a screen from the Administrator toolbar, and then click Customize, the Studio
opens with the screen you just captured. Only one screen or one template can be
opened in the Studio. You cannot customize both, or more than one screen, at the
same time.

To choose a screen to customize, click File > Open Map.

Some of the customization features include:
v Add facilities that allow the user to automatically navigate through the screens
v Add, copy, resize, and move existing screen objects
v Change the tab order
v Create new labels and text fields and edit existing ones
v Hide existing screen objects
v Create buttons, check boxes, choice boxes, frames, image buttons, list boxes,

radio buttons, valid values buttons, and Web link buttons
v Convert input fields to check boxes, radio buttons, choices, and lists
v Convert labels to buttons
v Add macro to automatically navigate users through the screens

(Get-to-the-Point)
v Redirect action keys
v Remap the keyboard
v Add customized buttons to the toolbar
v Pass data from screen to screen, combine screens and do calculations using

global variables
v Add context-sensitive help and valid values lists

Information about the features in the list above can be found in the online help.

Screen modes and customization
Host applications can have more than one mode for the same screen. For example,
the same screen might appear in Create, Review, or Update modes. Even though
the screen structure is the same for a screen in all modes, the status of specific
fields may be different depending on the screen mode. For example, in one mode,
the screen might have one or more specific fields displayed as labels, but a
different mode of the same screen might have these fields displayed as input
fields.

If your host application has screens running in different modes, carefully consider
what changes you make before making them. To capture screens separately, use a
tag. To use the same customization for all instances, be familiar with the host
application because a field could have a changeable appearance. Know the status
of the fields on the different host screens in all the modes these screens might
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have. For example, a label can appear empty and you will want to delete it or
move it. However, that label might contain information such as an error message
at a different time in the application.

Importing from other maps
For screens that have common objects, you can customize the common part of the
screen once and then export (copy) all or parts of the customization.

You can import any calculations from a screen to any other screen. This ensures
consistency across screens, and also saves time during customization. Use the
online help for steps on importing objects from maps.

Creating screen customizations for user groups
You can create unique sets of customizations for different groups of users. The
default directory for customization is custom. It contains the following
subdirectories: lang/help, map, img, lst, ref, and ps. To prepare different
customizations, you can create a new directory at the same level as the custom
directory. You have to set the parameter in the Administrator and Studio applet
files before you save and customize, otherwise the screens are saved in the default
directory. Save the customized screens in the new directory and then specify that
directory name in the client HTML file for Host On-Demand or the Parameters file
for Personal Communications with the subdir parameter. If no value is set, then
the user receives customizations from the default directory, /custom. If a value is
set, then the user receives the customizations from the directory specified as the
parameter’s value.

Applying templates
Templates can be applied in the Studio by clicking Screen > Template Options:
v Select Show with global template to see the screens with the global template.
v Select Show with specified template to see the screens with a specified

template.
v Select Do not show template to see the screens without the template.
v Select Only apply template colors and fonts to exclude all customizations

specified in a template except for colors and fonts.
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Chapter 8. Testing customized screens and templates

Customized screens and templates can be viewed in the Administrator. If you have
a session running, when you access the host screens that you’ve customized, the
screens contain the changes you made, including the template (if one was created).
If you have the Administrator and Studio running together and have just
customized a screen, you must click Actions > Refresh to see the customizations.

To see a screen in a different template, click Test > View with different template. To
use another template for your global template, change the usetemplate parameter
in the Client file (that starts the customized session) or the parameter file, if you
are using Personal Communications.

Get-to-the-Point and Web-link buttons do not work in the Administrator; you must
use the Client to test them.
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Chapter 9. Copying the customized files to other platforms

Customized screens can be placed on the Host On-Demand server or a network
drive for distribution. The Administrator and Studio are supported only in a local
environment (either a Host On-Demand server or local client install or a Personal
Communications local installation). Therefore, you cannot load the Administrator
through a Web server; it must be loaded from the local file system. Customization
must be done on an Administrator and Studio running on one of the supported
Windows platform (Windows 95, Windows 98, Windows 2000 or Windows NT 4.0)
and then moved to the non-Windows server.

Using customized files on a non-Windows Screen Customizer
RunTime Client (Host On-Demand)

After installing the Screen Customizer RunTime Client on a non-Windows server
(OS/400, UNIX, Sun, Netware, or OS/390), copy the customized files created by
the Studio on the Windows platform to the non-Windows server:
1. On the non-Windows server, display the contents of the Host On-Demand

publish/custom directory. Verify that the custom directory contains the
following subdirectories: lst, map, ps, and ref.

2. If these subdirectories do not exist, create them. Make sure the subdirectories
have the same permissions as the custom directory.

3. Transfer the contents of each subdirectory from the Studio workstation to the
corresponding server directory. Files must be transferred in binary.

The default publish directory on the server is /hostondemand/hod . For AS/400, the
default is qibm/proddata/hostondemand/hod .

Using customized screens with Host On-Demand
To use customized screens with Host On-Demand, enable Screen Customizer on
the Screen tab of the appropriate Host On-Demand session configuration, then
start the session.

Using customized screens with Personal Communications
To use customized screens with Personal Communications, click Start > IBM Screen
Customizer > Client. If a WS file has been specified using the Launch parameter, a
session starts; if not, you are asked to choose one. Start the session.
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Chapter 10. File extensions and directories

This table shows the various types of Screen Customizer files and where they are
stored.

Extension Purpose
Host On-Demand
Directory

Personal Communications
Directory

hlp User-created field-level help %publish%/custom/%lang%/help%pcomm%/custom/%lang%/help

scm Customization information %publish%/custom/map %pcomm%/custom/map

psd
Screen capture - text, field
attributes, color

%publish%/custom/ps %pcomm%/custom/ps

lst Valid-value lists %publish%/custom/lst %pcomm%/custom/lst

ref
References to field help &
valid-value lists

%publish%/custom/ref %pcomm%/custom/ref

tpl
Templates for
customization

%publish%/custom/map %pcomm%/custom/map

img Images (.gif, .jpg) %publish%/custom/img %pcomm%/custom/img

kbt Macro %publish%/custom/map %pcomm%/custom/map

ccf
Screen customization
preferences

Same directory as
associated WS file

Notes:
v %publish% is the Host On-Demand subdirectory published on the Web server.
v %lang% is the locale directory, for example, en for English or jp for Japanese.
v %pcomm% is the Personal Communications local installation directory.
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Chapter 11. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
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incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:
IBM Corporation
Department T01
Building B062
P.O. Box 12195
Research Triangle Park, NC 27709-2195
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Chapter 12. Trademarks

The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both: IBM

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and other countries.

Microsoft, Windows, Windows NT, and the Windows logo are registered
trademarks of Microsoft Corporation.

Other company, product, and service names may be trademarks or service marks
of others.
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